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Engaging in Reading: Computerized Graphic Organizers 
 

 

 
 

ICT -  Grade 12  (Issues in Human Rights) 
 

 
 

 

Graphic organizers help students improve reading comprehension by allowing them to visually represent their 
thinking.  Electronic graphic organizers assist students by allowing them to arrange and easily manipulate their 
ideas, exporting both text and image to a word processing document. While the example that follows relates to 
the Interdisciplinary Course, Issues in Human Rights, it can be modified to be used with any course.  Child 
Labour has been used as an example. 

Purpose 
• See the relationships among ideas, and distinguish between main ideas and supporting details. 
• Access information to synthesize and create new learning. 
• Know how to be productive using the most effective technology. 

Payoff 
Students will: 
• locate, gather and organize information using appropriate technology and information systems; 
• assess situations and identify problems; 
• seek different points of view and evaluate them based on facts; and 
• recognize the potential of Information Communication Technology as a learning tool.  

Tips and Resources 
• A picture book such as The Carpet Boy's Gift by Pegi Deitz Shea could be used to introduce the topic, 

allowing students to activate prior knowledge.  
• Beatrice's Goat by Page McBrier can be used to spark a discussion on the difference between child labor 

and child work. 
• Computerized tools such as SMART Ideas™ and Inspiration® contain pre-designed templates and also 

allow students to create their own charts/designs. 
• Here is a list of some possible web sites on Child Labour 

o Human Rights Watch - http://www.hrw.org/children/labor.htm 
o World Bank Group - http://www.worldbank.org/html/extdr/hnp/hddflash/workp/wp_00056.html 
o UNICEF - http://www.unicef.org/protection/index_childlabour.html 
o New Designs for Youth Development - 

http://www.cydjournal.org/NewDesigns/ND_98Fall/index.html 
o Free the Children - http://www.freethechildren.org/ 
o Peel District School Board - http://www.peel.edu.on.ca/student/model/resources2.htm 

• See Student/Teacher Resource: Introduction to SMART Ideas™ 
Consult Think Literacy: Cross-Curricular Approaches, Grades 7-12, p. 48 for more information regarding the 
use of graphic organizers. 
Consult Think Literacy: , Subject-Specific Examples, Computer Studies, Grades 7-9, p. 2-5 for information 
regarding Web site evaluation. 
Beyond Monet, Chapters 5 and 10. 

Further Support 
• Students with special needs may benefit from using adaptive technologies (e.g., Kurzweil) to assist with 

the web page reading. 
• Pair students or have them work in small groups. 
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Engaging in Reading: Computerized Graphic Organizers 
 

 

 
 

ICT -  Grade 12  (Issues in Human Rights) 
 

 
 

What teachers do What students do 
Before 
• Ensure that students know how to efficiently 

conduct Internet searches. 
• Ensure that students are able to evaluate web 

resources for authenticity, bias and perspective. 
• Ensure that students are aware of copyright 

responsibilities with regard to use of material 
found on the Internet. 

• Introduce the topic (child labour) to the 
students by reading the picture book The 
Carpet Boy's Gift or conduct a shared reading 
lesson using a web page on the topic.  

• Engage the students in a discussion.  
• Put students in pairs or in small groups. 

• Listen to the Read Aloud or read along 
with the teacher during the shared read. 

• Contribute ideas and suggestions to the 
class discussion. 

 

During 
• Instruct the pairs or groups to begin their search 

for information on the web. 
• After the students have had enough time to 

acquire some basic information on the topic, 
reconvene as a whole class to share their 
findings. 

• Demonstrate the use of the graphic organizing 
software to students by recording their ideas. 
(See Student/Teacher Resource: Introduction to 
SMART Ideas™.) 

• Allow the groups to decide which issues most 
interest them.   

• Challenge the students to create a web of 
information that they collect from the Internet. 

• Begin to research the topic (child labour) 
using both electronic and printed text. 

• Identify and share early findings with the 
rest of the class. 

• Contribute to the collection and 
organization of the information on a class 
web. 

• Select an area of interest and continue 
with the research. 

• Identify the key ideas and issues related 
to their specific topic and create a web of 
the information acquired through 
research. 

 

After 
• Challenge students to add appropriate relational 

words to the connecting lines of their web. 
• Put groups together to share and compare their 

information webs. 
• Ask students to reach consensus with regard to 

the main issues surrounding child labour. 
• Spark a discussion as to the students' beliefs 

with regard to human rights and the rights of 
children. 

• Present the United Nations Rights of the Child 
and encourage debate. 

• Read the picture book Beatrice's Goat by Page 
McBrier and discuss the difference between 
child labour and child work. 

• Encourage students to take action against child 
labor. 

 

• Confer among group members to add the 
words that show the connections between 
the ideas that they have on their web. 

• Students may join with members of other 
groups to create VENN diagrams 
comparing and contrasting the information 
that they learned. 

• Discuss what they might do to make a 
difference or help effect change. 

Notes 
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Engaging in Reading: Computerized Graphic Organizers 
 

 

 
 

ICT -  Grade 12  (Issues in Human Rights) 
 

 

 
Introduction to SMART Ideas™  

 
Within the SMART Ideas™ program, you will find the following templates: 

 
• Argument Strategy 

Model 
• Research Project • Fishbone Map 

• Family Tree • Venn Diagram • PERT Chart 
• Poetry Analysis • Timeline • Tree Diagram 
• Course Notes • Essay Planning • Cycled Events 
• Lesson Plan • Literary-Narrative-Analysis • Science Lesson 
• Spider Diagram • Sentence Building  
• Chain of Events • Presenting an Argument  

 
 

The web site to visit for downloading is:  http://www.smarttech.com/support/software/index.asp  
 

The web site to visit for lessons and examples is:  
http://www.edcompass.smarttech.com/en/learning/activities/ideas.aspx   

 
 

To use a template: 
 

• Open Smart Ideas. 
• Go to File and scroll down to Open Template. 
• Scroll down to choose a template from the list (e.g., Language Arts - Family Tree). 
• Click Open. 
• Triple click a box to remove the place holder and type in your information. 
• You can create your own templates and make them available in the list by saving them to the Templates  

Folder within the program. 
 
 

Adding Symbols to a new project from the menu bar: 
 

• Open Smart Ideas. 
• If the program has been set to show the dialogue at startup, select <Blank Diagram>. 
• If the dialogue box does not auto-launch, go to File and Open. 
• Select <Blank Diagram>. 
• Double Click or click and drag one of the Symbols at the left to add it to your page. 
• Click it to add the title of your project. 

 
 

1 of 4 continued on next page… 

Teacher/Student resource
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Using the Connector Tool: 

 
• Click off the symbol and back on to get the Connector Tool. 
• Click the connector tool and drag the crosshair to get another symbol. 
• Type the title (e.g., name of your book, research topic). 
• Do this as many times as you need to create a new box. 
• Note: Using the Quick Connect tool on the top tool bar will allow you to 

add a new symbol quickly, by clicking on the original symbol.  A small box 
will appear in which you can type the name of the next symbol.  When you 
click off, the new symbol will be added. 

 
You may add text to a connector line.   

 
• Click on a connector line once to select; twice to get a text box. 

 
• A connector style may be changed by first clicking on it to select it,  

and then clicking once on a different connector from the list at the left. 
 
 
 
 
 
 
 
 

Layouts and Formatting:  
 

• Click on Layout on the top tool bar to be given a choice of ready-
planned layouts. 

 
 
 
 

• You can change your symbol by going to Format at the top  
and scrolling down to Shape.  You can also make some other 
formatting changes. 

 
 

Objects can be resized by clicking on their bottom right corner and 
 dragging either larger or smaller. 
 
 

Adding Notes: 
 

• Click the shape in which you would like to add a note 
and click Note at the top. 

 
• Your symbol will now show when a note is 

attached. 
 
2 of 4 continued on next page… 



6 

 
 
T H I N K  L I T E R A C Y :  C r o s s - C u r r i c u l a r  A p p r o a c h e s ,  G r a d e s  7 - 1 2  

  

 

R 
 
 
 
Changing Symbols to Clipart: 
 

• Click the symbol. 
• Click Clip Art at the top left. 
• Locate an image and double click it. 

 
 
More on Clipart: 
You may also use clip art instead of a symbol in your diagram.  
 

• Click Clip Art at the right. 
 
 
• Click and drag or double click an image to place it on the page. 
• You may then click it to add text which will appear below the image. 
 
 

You can add more clip art to the program. 
• Click Customize under the images at the bottom left. 

• Select Add Clip Art and locate an image on your computer. 
• Click the image and OK. 

 
 
 
 
 
Blank Text Boxes 
There will be times (e.g., when using a Venn Diagram) that you would like to be 
able to add a blank text box to an object. 

• Click through the pages of objects at the left -  to page 5 
• Click one of the 4 last boxes and drag it on to the page. 

 
 
 
 
 

 
 
 
 
These boxes will allow you to type and use the return/enter key. 

 
 
3 of 4 continued on next page… 
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Using Levels: 
• Click the small green arrow on the upper right corner of a symbol that will appear when it 

has been selected.  If a level has already been made, then the green arrow will remain even 
when the symbol is not selected. 

• When you are through working on a sub-level, click Main at the upper right of the screen to return. 
 

Creating Links: 
Active Links to Web Pages, Files and other Levels may also be added to your 
document.  

 
• Click on the piece of clip art or symbol on the page to select. 
• Click the paper clip at the top.   
• Type or paste the URL to a Web page onto the line; or 
• Browse to locate and attach a file. 
• Click OK. 
• A small paperclip will be attached to the image that when clicked will launch the file or Web page. 

 
Creating Transparency (especially helpful when creating a Venn diagram): 

 
• Right click the symbol. 
• Scroll down and select Transparency.   
• You may also go to Format at the top and 

Transparency. 
• To add information to the Venn, create another 

symbol for each of the outer sections of the 
circles and another in the middle. 

• To remove the color from this shape, with it 
selected, click the down arrow by the paint can 
at the top and select No Color. 

• To remove the line, select the symbol, click the 
down arrow by the pencil at the top and select No Color. 

 
  
 

Saving and Exporting (under File): 
 

• Organizers created may be saved as Ideas Projects or Templates. 
 
• When Exported to the Web in either Diagram or Outline View, a folder will be created containing the 

document as HTML, an HTML Index file and a Fireworks document. 
 
• Files can also be saved/exported to Microsoft Word or Word Perfect. The application chosen will open 

containing the picture of the diagram and the text outline. 
 
• By choosing Send Mail, an email message will be generated with the HTML diagram attached. 
 
• To create a .jpg of the diagram, select and copy all of the objects in the diagram and paste in a graphics 

program (e.g., Adobe Photoshop Elements or Microsoft Paint) Select .jpg when saving. 
When printing, you may select the current level or all of the levels. 
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Reacting to Reading: Responding to Text (Spider Maps) 
 

 

 
 

ICT Grade 11 (Sports & Society) 
 

 
 

 

There are a variety of ways in which readers can react to a text.  This strategy can be used before and/or after 
an assigned reading.  The strategy involves students working in pairs or small groups.  The teacher sets up as 
many computers as there are pairs or small groups.  The students work to develop reactions to the text using 
graphic organizer software that will help them to develop a better understanding of the topic.  While the 
example that follows relates to the interdisciplinary course, Sport and Society, it can be modified to be used 
with any course.  The Olympics has been used as an example. 

Purpose 
• Provide an opportunity for students to make a personal connection to a topic or unit of work by expressing 

their opinions, demonstrating their understanding of the assigned text, and making connections to their 
prior knowledge and experience. 

• Provide an opportunity to integrate technology into a meaningful learning environment for students. 

Payoff 
Students will: 
• connect their personal knowledge and experience with the assigned topic; 
• expand their understanding of the reading by exploring the ideas and opinions of others; 
• locate, gather and organize information using appropriate technology and information systems; and 
• recognize the potential of Information Communication Technology as a learning tool. 

Tips and Resources 
• Provide students with graphic organizer software packages (such as SMART Ideas™, licensed for use in 

Ontario schools by OSAPAC at www.osapac.org)  
• For step-by-step instructions on leading the class through graphic organizers using SMART Ideas™, see 

Teacher Resource, Introduction to SMART Ideas™, in the Computerized Graphic Organizer strategy. 
• For ways to extend graphic organizers used during reading into writing activities, see the Webbing and 

Mapping strategy in the Writing section. 
• See Teacher Resource, Electronic Spider Map Examples for further assistance. 
• See Teacher Resource, Extensions for Spider Maps, for further ideas. 
• See Teacher Resource, Website Supports for readings about the Olympics, if required. 
• See Student Resource, Spider Map Checklist. 

Further Support 
• The use of graphic organizers in previous lessons will allow students to build on their prior knowledge by 

adding the electronic component.  Concept attainment and the use of exemplars may enhance this task.  
Teachers using spider mapping for the first time with students may provide more prompts to begin the 
task. 

• An LCD projector, SMART™ board or overhead projector can be used to show students the step-by-step 
process of creating a concept map permitting visual learners to follow easily. 

• Students should be given adequate space to see the computer screen and type comfortably.  Students 
with special needs should be given appropriate support (e.g., voice recognition software and other 
adaptive technology).   

• Groupings should consider students’ strengths and needs, particularly in terms of language (reluctant 
readers, ESL students…) and computer skills. 
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Reacting to Reading: Responding to Text (Spider Maps) 
 

 

 
 

ICT Grade 11 (Sports & Society) 
 

 
 

What teachers do What students do 
Before 
• Preview graphic organizer software. 
• Access enough computers with the graphic software 

package for your students.  
• Review the elements of a spider map with 

examples.  See Teacher Resource, Examples. 
• Introduce challenging vocabulary. 
• Discuss the Olympics to build on prior knowledge. 
• Assign a reading to students relating to the 

Olympics.  See Teacher Resource, Website 
Supports. 

• Have students select pairs/groups or place students 
in pairs or small groups. 

 

 
 
 
 
• Recall what they know about spider 

maps. 
 
• Recall what they know about the topic 

and participate in a discussion. 
• Read the assigned text. 
 
• Put themselves in groups of 2 to 3 or 

listen carefully as the teacher puts them 
in groups. 

 
During 
 Review the process of spider mapping using graphic 

organizer software. (See Teacher Resource: 
Introduction to SMART Ideas™)   

• Have students use the blank template to get started.  
Discuss possible reasons for spider mapping and 
where to start. 

• Use the Think/Pair/Share strategy to discuss the 
reading.  Have students think about what the 
reading meant, then, after sufficient time, share their 
thoughts with a partner.  Write down ideas. 

• Have students develop their initial points from their 
list (e.g., Ancient Olympics, Early Modern Olympics 
and Current Olympics; Achievement, Struggle and 
Change; Likes, Dislikes, and Questions…) 

• Instruct students to explore the reading further by 
developing their spider map.    See the Student 
Resource, Spider Map Checklist. 

• Support groups with prompts as required. 
 

• Listen carefully to instructions about the 
software.  Take notes and clarify as 
needed. 

• Participate in a discussion.   
• Think about the reading.  What are the 

main points?  Discuss the reading with 
a partner and generate a list of key 
ideas using sticky notes or by 
highlighting the text.  Ideas can be listed 
on paper, or by using the computer’s 
word processor. 

• Consider your list of ideas to determine 
what your four main ideas will be. 

 
 
• Continue to develop your spider map.   

Use the checklist to enhance your 
understanding. 

 

After 
• Review the spider maps created initially by 

students. 
• Provide copies of spider maps for students to 

review. 
• Discuss the reading and the perspectives taken in 

the different concept maps. 
• Provide formative feedback.   
• Use the spider maps for further extension.  See 

Teacher Resource, Extensions Using Spider Maps. 

• Submit spider maps to the teacher. 
 
• Review the spider maps of other 

groups. 
 
• Participate in a discussion. 
 
• Consider formative feedback. 
 
 
 

Notes 
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Reacting to Reading: Responding to Text (Spider Maps) 
 

 

 
 

ICT Grade 11 (Sports & Society) 
 

 

 
 

Electronic Spider Map Examples  
 

To the right : 
Blank Spider Map Template  
 
Below : 
Completed Spider Map about the  
Ancient Olympics 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Teacher Resource
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Reacting to Reading: Responding to Text (Spider Maps) 
 

 

 
 

ICT Grade 11 (Sports & Society) 
 

 
 

 
Extensions Using Spider Maps 

 
As their name suggests, graphic organizers help students organize the information being delivered, their thoughts 
and their opinions.   While spider maps are extremely useful as students respond to a text, much like Venn 
diagrams and Fishbone diagrams, spider maps are a simple tool that can also be a starting point for more complex 
tasks.    
Below are a list of some ways that spider maps can be extended in future lessons and units: 

 
• Using the “notes” tool, have students return to 

their spider maps to add further comments 
once they have learned more in a unit.  

 
• Using the “notes” tool, have different groups 

comment on each others’ spider maps, adding 
comments and questions. 

 
• Have students research further to find the 

answers to any questions that have been raised 
while creating the spider map. 

 
o For example, have students explore why the festivals for Zeus and Hera involved men and unmarried 

women competing separately.  Find out when women began to participate in the Olympics and their 
changing degrees of participation. 

 
• Use one or more spider maps during the unit as a starting point for a more complex organizer, such as a mind 

map or concept map.  Using graphic organizer software allows students to easily adapt the spider map into a 
more complex organizer (including adding descriptors to the lines and images to the written text).   

 
o For example, have the students complete readings on a number of topics related to the Olympics, 

including the Ancient Games, the Modern Games, the Paralympics and the Special Olympics using the 
spider map strategy.  Then, use the spider maps to create a concept map exploring the Olympic 
Movement. 

 
• Use the spider map as the “study notes” during a quiz or test. 
 
• Use the spider map as an organizer during the writing process for an essay. 

 
o For example, use the “Outline View” in SMART Ideas™ to easily convert the spider map into an outline 

for an essay or report. 
 

• Use the spider map as a diagram to be included in a report. 
 
• Use the spider map as a tool to help students generate ideas in a written response. 

o For example, have students explore how the Ancient Olympics reflected the values of Greek society at 
the time. 

Teacher Resource 
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Reacting to Reading: Responding to Text (Spider Maps) 
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Website Supports 
 

Note:  These websites were active at the time of writing. If teachers are going to have students select readings, ensure 
that they are still active and appropriate before distributing.   

 
The Official Site of the 
Olympic Movement--IOC 
 

http://www.olympic.org/uk/index_uk.asp 
 

Canadian Olympic 
Committee Home Page--
COC 
 

http://www.olympic.ca/EN/ 
  
 
 

Olympics--CBC 
 

http://www.cbc.ca/olympics/ 
 

International Paralympics 
Committee Home Page--
IPC 
 

http://www.paralympic.org/release/Main_Sections_Menu/index.html 
 

Paralympics--IOC 
 

http://www.olympic.org/uk/games/paralympic/index_uk.asp 
 

Olympics Through Time-- 
Foundation of the 
Hellenic World 
 

http://agones.fhw.gr/ 
 

Special Olympics Canada 
Home Page--Special 
Olympics Canada 
 

http://slam.canoe.ca/CanadianSpecialOlympics03/0211.html 
 

The Ancient Olympics--
Perseus Digital Library 
Project 
 

http://www.perseus.tufts.edu/Olympics/ 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Teacher Resource



13

 
 

T H I N K  L I T E R A C Y :  C r o s s - C u r r i c u l a r  A p p r o a c h e s ,  G r a d e s  7 - 1 2  
 

 

R
 
 
 

 
 

Reacting to Reading: Responding to Text (Spider Maps) 
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Spider Map Checklist 

 
Name(s):_____________________________  Reading:________________________________ 

 
Complete the following checklist to be sure that the spider map is complete and accurate. 

 
Have we… Yes Needs Improvement 
Read over the article at least once for understanding? 
 

  

Thought about the article individually? 
 

  

Discussed the article with a partner? 
 

  

Read over the article to select key points (using sticky 
notes, a highlighter, or taken notes)? 

  

Selected an appropriate topic for the middle of the spider 
map? 

  

Selected three to four key ideas as the main branches of 
the spider map? 

  

Developed each main branch with at least three 
supporting details? 

  

Checked that facts are accurate? 
 

  

Included most of the key points selected during reading 
and discussion? 

  

Made sure that all writing can be seen (shapes/fonts are 
adjusted as needed)? 

  

Made sure that shapes do not overlap (click and drag to 
move shapes as needed)? 

  

Used tools to help organize ideas clearly for others to 
follow (fill colour, text colour, font, shapes, bolding…)? 

  

Avoided using colours and/or contrasts that may not print 
well (such as yellow, dark colours with dark writing…)? 

  

Discussed whether all members of the group agree with 
what has been included (and omitted) on the spider map? 

  

Checked that the language is clear and precise? 
 

  

Student Resource 
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Revising and Editing: Peer Editing 
 

 

 
 

Integrated ICT Grades 7-12 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Peer editing gives students an opportunity to engage in important conversations about how a piece of writing 
for an assignment has been constructed and whether it achieves its purpose, considering the audience. By 
reading each other’s work, asking questions, and identifying areas of concern, students learn a great deal 
about how to put information together and express ideas effectively.  Word processors, now ubiquitously used 
in other phases of the writing process, are often left out of this part and yet have embedded features to greatly 
simplify the editing stage.  The peer editing skills acquired through the use if this strategy can be integrated 
throughout the curriculum. 

Purpose 
• Encourage students to look at their own and others’ writing with a more knowledgeable, critical eye. 
• Use word processors more effectively throughout the writing process. 

Payoff 
Students will: 
• have an audience for the writing, other than the teacher; 
• develop skills in editing and proofreading, using features in word processors designed for this purpose; 
• receive peer input about possible errors and areas of concern, in a “low-risk”, simple process; and 
• have positive, small-group discussions. 

Tips and Resources 
• Peer editors should not be expected to correct all of the writer’s errors, since the writer is responsible for 

the piece’s clarity and correctness. Rather, the teacher and other students should provide support for the 
writer to make corrections. 

• Peer editors should have access to an easy method of accessing the writer’s work (e.g., shared network 
drive, diskette, memory key). 

• Peer editing is a skill that must be built and practised over time. Begin with a single focus (such as writing 
an interesting and effective introduction), then add elements one at a time, such as: 

o appropriate paragraphing 
o detail and support for topic sentences 
o appropriate subject-specific vocabulary and sentence variety 
o conventions of writing (grammar, punctuation, and spelling) 

• This strategy may be used more intensively when time permits or when the writing assignment is 
particularly significant (e.g., a culminating task). In these cases, student work may be edited by more than 
one group, so that each student receives feedback from a larger number of peers. 

• However the time or students are organized, each student should have the opportunity to get feedback 
from at least two other students. 

      See Think Literacy, Cross-Curricular Approaches: Student Resource, Sample Peer-Editing. 

Further Support 
• Consider balancing each group with students who have varying skills and knowledge to bring to the peer-

editing process. More capable peer editors will act as models for the students who haven’t yet 
consolidated the concepts or skills. 

• Explain to students that you have designed the triads or groups to include a very creative person, a 
person with good technical skills, and one or more persons who will provide a very honest audience for 
the writing. 

• Consider turning some of the questions into prompts (e.g., the best piece of writing is . . . ; I’d like more 
information about . . . ; I was confused by . . .). 



15

 
 

T H I N K  L I T E R A C Y :  C r o s s - C u r r i c u l a r  A p p r o a c h e s ,  G r a d e s  7 - 1 2  
 

 

W
 

 

Revising and Editing: Peer Editing 
 

 

 
 

Integrated ICT Grades 7-12  

 
 

What teachers do What students do 
Before 
• Ask students to bring a completed draft of a 

writing assignment on a specified date. 
• Divide students into groups of three or four. 
• Distribute the instructions for the word 

processing software being used (see 
Student/Teacher Resources). 

 

• Bring a completed draft of a writing 
assignment to class on the specified date. 

During 
• Give directions for the peer-editing process: 

o One group exchanges writing pieces with 
another group. 

o Group members read the writing pieces, 
making notes about reactions, questions, 
and concerns. 

o As each member of the group finishes one 
piece of work, they should pass it on to 
another group member. 

• Remind students that they are not responsible 
for correcting all the writer’s errors, but that they 
can add comments for areas of concern, or 
mark words/phrases that should be checked. 

• Monitor and support the group processes. 
 

• Exchange their pieces of writing with 
another group. 

• Individually read and annotate all 3 or 4 
pieces from the other group (using the 
features in the word processor) as the 
pieces pass from person to person. 

• Remember that the writer owns the writing; 
therefore, the reader is not primarily 
responsible for correcting all the writer’s 
errors. 

After 
• Debrief the activity with the class, asking 

questions such as: 
o What were the strengths you noticed in the 

best pieces of writing in various areas (e.g., 
in the introduction, supporting details or 
examples, or conclusion)? 

o What were some typical weaknesses? 
o What types of things will you have to do to 

improve your work? 
• (Optional) Assign another draft, or a completed 

final draft, of the same assignment. 
• (Optional) Provide time for each student to 

engage in a brief conference with a student who 
peer-edited his/her piece of writing, to get more 
complete feedback and a deeper understanding 
of the comments and suggestions. 

 

• Take part in the class debriefing discussion.
 

 
 
 
 
 
 
 
• Complete subsequent draft, if assigned. 
• Confer with one other student to provide 

more complete feedback and comments or 
suggestions. 

 
 
 
 

 
 

Notes 
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Peer Editing with Microsoft Word 
 

The following are a few features of Microsoft Word (ver. 2002) that are designed to simplify the peer-editing portion of  
the writing process.  Though commands/steps may differ slightly in other versions of the program, it is likely that similar  
steps can be taken to accomplish the same task(s). 
 
 
 

 Protecting Your Document 
 
In advance of the peer editing process, any part of a document that will not be subject to editing can be protected.  By  
protecting the document before submitting it to peers, the author can ensure that changes to the original work are not 
inadvertently introduced. 

Steps: 
• Navigate to the Tools menu, and select Protect Document.  
• The author should then select one of the following:  

o To let reviewers change the document by inserting comments and tracked changes, click Tracked changes.  
o To let reviewers only insert comments, click Comments.  
o To let authorized reviewers “unprotect”  the document, type a password in the Password box. 

 
 
 

Tracking Changes 
 

As reviewers make changes to a document, Word allows the preservation of the original layout of the work, while  
   showing the changes in balloons in the margins.  In this way, an author can later review and then accept or decline  

 suggestions for changes in a quick and efficient manner. 

Steps: 
After opening the draft, each person involved in the editing process should change the name used in comments: 

• Navigate to the Tools menu, select Options, and then select the User Information tab.  
• In the Name box, each editor should provide his or her name before making any changes to the work. 
• An editor can change the color that Word uses to mark changed items - see the Help menu in Word for details. 

 
The person editing should then ensure the Track Changes feature is turned on (TRK should appear in the status bar at the bottom,  
it is dimmed when the feature is turned off): 

• Navigate to the Tools menu, and select Track Changes. 
• The editor should then make changes that can include: inserting, deleting, moving text or graphics, changing formatting, etc. 
• Save the document and pass on to the next editor (repeat the above), or return to the author (see Working with Changes and 

Comments). 
 
2 of 2 continued on the next page… 

 
 

Revising and Editing: Peer Editing 
 

 

 
 

Integrated ICT Grades 7-12 
 

 

Student/Teacher Resource
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Adding Comments 
 

Editors can and should do much more than correct spelling and grammatical errors when looking at a piece of work.  They 
should think about whether the writing is interesting, if ideas are clearly expressed, if the writer achieves the purpose of the 
assignment etc.  Adding a comment to a piece of work is an easy way to explore these and other questions for both editors and 

the author.  

Steps: 
• Select the text or item you want to comment on, or click at the end of the text.  
• From the Insert menu, choose Comment.  
• Type the comment text in the comment balloon. 
• To get rid of a comment, right-click the comment, and then select Delete. 

 
 

Working with Changes & Comments 
 

When the author receives the original document back with feedback from at least two editors he or she 
is ready to review the tracked changes and/or comments. All the suggestions editors have provided should be 
carefully reviewed, but should not be blindly accepted. 
Steps: 

• If the changes are not displayed, ensure that Markup in the View menu is turned on; in addition, reviewing is simplified with the 
proper toolbar available – if the Reviewing toolbar is not visible, make it so by selecting the Insert menu, then Toolbars, and 
Reviewing. 

• Some of the button functions are described below. 
 

 

 
By accessing the Show option on the toolbar, the author can opt to review only certain 
items, or from certain reviewers.  Also, a Reviewing Pane can be opened up to see a 
different view of the editing changes.  Finally, options can also be altered by using  this 
selection. 

  
These buttons enable the author to sequentially review the previous and next items. 
 

  
These two buttons allow the author to accept or reject items.  Click on the arrow to the right 
of each icon to see other options for accepting/rejecting items. 
 

  
Turns the Track Changes feature on/off. 
 

 
• A document can be printed with tracked changes and comments showing by going to the File menu, choosing Print, in the Print what 

box, selecting Document showing markup, and clicking OK.  
• Alternatively, a list of changes can be printed by going to the File menu, choosing Print, in the Print what box, selecting List of 

markup, and clicking OK. 
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Revising and Editing: Peer Editing 
 

 

 
 

Integrated ICT Grades 7-12 
 

 

 
 

Peer Editing with WordPerfect 
 
The following are a few features of the Ministry-licensed software WordPerfect (ver. 10) that is designed to simplify the 
peer-editing portion of the writing process.  Though commands/steps may differ slightly in other versions of the program, it 
is likely that similar steps can be taken to accomplish the same task(s). 
 
 
 

Tracking Changes 
 

As reviewers make changes to a document, WordPerfect allows the preservation of the original layout of the 
work, while showing proposed changes in different colours.  In this way an author can later review and then 
accept or decline suggestions for changes in a quick and efficient manner. 

Steps: 
After opening the draft, each person involved in the editing process should change the name used in the comments: 

• Navigate to the File menu, choose Document, then Review. 
• Click Reviewer. 
• In the dialog box, type your name and initials, and click OK. 
• Select whether you would like to place a marker in the margin where text is edited. 
• Click the Set color button on the property bar, and click a colour on the color palette to choose a colour for your 

changes. 
 
Note: In some cases, different editors may need to change the user information (name, colour etc.) if using the same 
computer as another.  This can be accomplished by: 

• Navigate to the Tools menu, and select Settings. 
• Click on Environment. 
• In the dialog box, click the General tab. 
• Type your name in the Name box. 
• Type your initials in the Initials box. 
• On the User color palette, click a colour for your comments. 

 
At this point the person editing can make changes to the document - using all WordPerfect features except Sort. Text 
editing changes are marked with the colour the user originally selected.  Subsequent reviewers can edit additions that 
other users have made, but cannot edit or undo previous deletions that other users have made.  Once editing is complete, 
the reviewer should select Close on the reviewing toolbar, and save the document. 
 
 
 
 
 
 
1 of 2 continued on the next page… 

Student/Teacher Resource
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Adding Comments 
 
Editors can and should do much more than correct spelling and grammatical errors when looking at a piece of 

work.  They should think about whether the writing is interesting, if ideas are clearly expressed, if the writer 
achieves the purpose of the assignment etc.  Adding a comment in a piece of work is an easy way to explore these 

and other questions for both editors and the author to explore.  

Steps: 
• Move to where you want the comment to display. 
• Go to the Insert menu, select Comment, then Create. 
• Type the comment text. 
• Click Close to return to the main document text. 
• WordPerfect places a comment icon (box) with the initials of the person making the comment in the margin. 
• To delete a comment, simply right-click the comment or comment icon, and select Delete. 
• To convert a comment into text, click on the comment and go to the Insert menu, select Comment, then Convert to text. 

 
 
 

Working with Changes & Comments 
 

When the author receives the original document back with at least two editors having worked with the 
document, he or she is ready to review the tracked changes and/or comments.  The author should carefully 

review all the suggestions editors have provided, but should not blindly accept them all. 

Steps: 
   To review changes your peers have suggested: 

• Navigate to the File menu, select Document, then Review. 
• Click Author. 
• You will be able to see the colour(s) associated with each of your reviewers at the top of the reviewing toolbar. 
 
 
• Use the following buttons on the reviewing toolbar to assist with the editor’s annotations: 

o Go to previous - moves to the previous change.  

o Go to next - moves to the next change.  

o Show/hide - displays or hides margin markers.  

o Display annotations - shows the edited text with or without color markings.  

o Insert current annotation - accepts the current annotation.  

o Insert all annotations - accepts all annotations.  

o Delete the current annotation - rejects the current annotation.  

o Delete all annotations - rejects all the annotations in the document.  
 

• Once all changes and comments have been reviewed, remember to save the document. 
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Generating Ideas: Using Digital Images 
 

 

 
 

Integrated ICT  Grades 7-12  
 

It’s been said that a picture is worth a thousand words. Photographs often can give you an understanding of a 
subject in a way that words cannot. For many writers who have difficulty mentally visualizing what they want to 
write about, photographs can serve as a starting point.  
 
Many schools now have access to digital cameras and scanners. Students also may have access to personal 
or family owned digital cameras.  They can be used to capture images at a variety of school events or field 
trips. These images may be used as starters for writing activities. They may also be included in the writing to 
further illustrate the student’s ideas. 
 
Students can use their own digital photographs as story starters or they can use photographs taken by others. 
 
The skills acquired through the use of this strategy can be integrated throughout the curriculum. 
 

Purpose 
• Help students generate ideas for writing through the use of photographs taken by themselves or others. 
• Identify important ideas suggested by the photograph through training in visual literacy. 
• Have students write an article for publication that complements and builds on a photograph. 

Payoff 
Students will: 
• use digital photographs to bridge from an image to text; 
• use digital photographs to provide an entry point for writing; and 
• use digital photographs as scaffolding for writing by allowing physical rather than mental visualization. 
 

Tips and Resources 
• A variety of Word Processing or Desktop Publishing programs (e.g., Microsoft Word, Word Perfect, 

AppleWorks, Microsoft Publisher) can be used by students to assist them in the writing process.  
• The use of graphic organizers will allow students to organize the information that they retrieve from digital 

photographs. 
• The Internet is an invaluable source of information on the use of digital images to support the writing 

process. 
• See Teacher Resource, Resources for Teaching Writing With Digital Photographs. 
• See Teacher Resource, Other strategies for using digital images to generate ideas for writing. 
• See Student Resource, Photo Start Writing. 
• See Teacher Resource, A Process Guide for Photographs. 

Further Support 
• Programs such as Photoshop Elements (licensed for use in Ontario schools by OSAPAC – 

http://www.osapac.org) may be used by students to enhance and modify digital photographs. Students 
can modify photographs to create situations that never existed and then challenge their peers to write 
imaginative stories. 

. 
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Generating Ideas: Using Digital Images 
 

 

 
 

Integrated ICT  Grades 7-12  
 

 

What teachers do What students do 
Before 
• Book the necessary equipment for the 

lesson (computers, digital cameras). 
• Review the process for studying a 

photograph. (See Teacher Resource, A 
Process Guide for Photographs).  

• Model for the students the process of 
using a prepared digital image to 
stimulate ideas for writing. 

• Illustrate the use of similes and 
metaphors (e.g., silent sentinels, forest of 
iron trees for power transmission towers). 

• Lead students through a number of 
examples. 

• Ensure that students are familiar with 
proper methods of citation. 

 
 

• Become familiar with the use of the digital 
cameras that are available to them. 

• Participate in a class activity with the teacher 
in reviewing photographs using the Process 
Guide for Photographs. 

During 
• Provide time and opportunities for 

computer activities including writing the 
article. Offer a rotating schedule, if 
necessary, within the classroom for 
computer use and digital camera access. 

• Give ongoing opportunities for peer 
assessment and feedback. 

• Remind students to cite the source of the 
digital images that they are using. 

• Provide individual feedback. 
 

• Collect additional images to support their 
articles. 

• Using the Student Resource, Photo Start: 
Writing, complete all of the tasks. 

• Write their articles on the use of electricity in 
the province. 

 

After 
• Have students debrief and reflect based 

on their experiences in this unit and the 
feedback from their peers. 

• Challenge students to identify the impact 
of the photograph on their writing. 

 

• Share the final reports with peers. 
• Explain how digital images helped in the 

writing of articles. 

 
 
 
 
 
 
 
 
 
 

Notes 



22 

 
 
T H I N K  L I T E R A C Y :  C r o s s - C u r r i c u l a r  A p p r o a c h e s ,  G r a d e s  7 - 1 2  

  

 

W 
 
 

 
 

Generating Ideas: Using Digital Images 
 

 

 
 

Integrated ICT  Grades 7-12  
 

 
Other strategies for using digital images to generate ideas for writing 

 
Then and Now 

o Ask students to scan a photograph of a parent or grandparent when they were the same age and have them 
compare it to digital photographs of themselves. Have them write about the similarities and differences of 
being a teenager in these two times. 

o Have students scan photographs from the school archives (or old yearbooks) and have them compare the 
photographs to digital photographs of the same activity or location today. Ask them to identify what’s changed 
and what’s remained the same and to write an article about these changes. 

o Ask students to scan photographs of their homes, streets, towns, or cities that were taken many years ago. 
Have them compare these images to digital photographs of the same locations today. Ask them to identify 
what’s changed and what’s remained the same and to write an article about the changes. 

 
Put Yourself into an Historic Painting or Photograph 

o Ask students to select an historic painting or photograph that interests them. 
o Challenge students to place themselves in the painting or photograph by scanning it and then inserting a 

photograph of themselves through the use of a digital editing program. 
o Have them prepare a report on the event in the photograph or painting from a first person perspective. What 

was it like to be there? 
   

Photo Essays 
o Ask students to take seven to ten photographs that tell a story and assemble them into a 

storyboard.  
o Have them caption each of the photographs.   
o Have them write a story that parallels the storyboard. 

 
Similes and Metaphors 

o Have students examine an interesting photograph taken by another student or from an Internet source. 
o Ask them to create similes and metaphors that describe items in the photograph. 
 

Poetry 
o Have students examine an interesting photograph taken by them, another student, or from an Internet source. 
o Ask them to create a poem in a given format that reflects the photograph. 
 

Virtual Field Trip 
o On a trip to an interesting historic site or other environment, have students record what they see with their  

digital cameras. 
o Have them prepare a report on the visit with the aid of the photographs.  

 
Illustrating the Steps in a Process  

o Have students document a process using digital photographs. 
o Ask students to write a set of instructions to accompany the photographs. 

 
 

(photos by Ron Millar) 
 

 
 

Teacher Resource
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Generating Ideas: Using Digital Images 
 

 

 
 

Integrated ICT  Grades 7-12  
 

 
PhotoStart:  Writing 
 
You’ve been asked to write a two-page article for the school newspaper 
about the use of electricity in the province and the need for conservation.  
You don’t know where to start.  Your editor has given you two photographs 
to be included in the article. Often a photograph will give you an idea to 
‘jump-start’ your writing.  

 
1. Identification of the photographs 

a. What is the topic of the photographs? 
 

2. Purpose of the photograph 
a. Why were the photographs taken? 
b. Is there a theme or event being shown? What is it? 
c. What is the photographer trying to show the viewer? 
 

3. Composition of the image 
a. Examine the subjects, colours, and sections of the photograph. What is their importance? 
b. Is the photograph divided into parts? Examine the background and the foreground. 
 

4. Effectiveness of the photograph 
a. What message does it convey? 
b. Does the photograph tell a story? What questions does it make you ask? 
c. Does the photograph allow you to make inferences, deductions, or generalizations about its 

content. 
 

5. Image Analysis 
a. What are the characteristics of the landscape – terrain, buildings, 

etc.? 
 

6. What do the transmission towers remind you of? Express this as a 
simile or a metaphor. 

 
7. Begin your article with a dramatic and colourful reference to these 

transmission towers. 
 

8. Take some additional photographs of the use of electricity around 
your community and use these photographs and data from the 
Internet to complete your report. 

 
 
 
 

Student Resource 



24 

 
 
T H I N K  L I T E R A C Y :  C r o s s - C u r r i c u l a r  A p p r o a c h e s ,  G r a d e s  7 - 1 2  

  

 

W 
 

 

Generating Ideas: Using Digital Images 
 

 

 
 

Integrated ICT  Grades 7-12  
 

 
Resources for Teaching Writing with Digital Photographs 
 
Note:  These websites were active at the time of writing.   
If you are going to have students select readings, ensure that they are still active and appropriate before distributing. 
 
Digital Cameras 
 
Kathy Schrock 
on Digital 
Cameras 

http://school.discovery.com/schrockguide/gadgets.html 
 

Digital Camera 
Reviews 

http://www.shopping.com/xGS-digital%20camera%20edition~NS-
1~Linkin_id-3061697 

Teaching with 
Digital Cameras 

http://www.tech4learning.com/services/teachingwithdigitalcameras.htm 

 
Scanners 
 
NCTE Scanners http://www.ncte.ie/ICTAdviceSupport/AdviceSheets/Scanners/ 

  
 
 
Articles 
 
Teaching with Photographs http://www.learnnc.org/articles/vlphotosites0602 
Reading Photographs http://www.learnnc.org/articles/vlphoto0602-1 
 
 
 
Images 
 
Images Canada http://www.imagescanada.ca/index-e.html 
National Geographic 
Photography 

http://www.nationalgeographic.com/photography/ 

NASA Photo Journal http://photojournal.jpl.nasa.gov/index.html 
 
 
 
 
 
 
 
 
 

Teacher Resource 
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A  Process Guide for Photographs 
 

The questions in this process guide will not apply to all photographs. The student will have to  
determine which apply. 

 
1. Identification of the photograph 

a. Who was the photographer? 
b. What is the source of the image? 
c. What is the topic of the photograph? 
 

2. Purpose of the photograph 
a. Why was the photograph taken? 
b. Is there a theme or event being shown? What is it? 
c. What is the photographer trying to show the viewer? 

 
3. Composition of the image 

a. Examine the subjects, colours, and sections of the photograph. What is their importance? 
b. Is the photograph divided into parts? Examine the background and the foreground. 

 
4. Effectiveness of the photograph 

a. What message does it convey? Does the photograph tell a story?  
b. What questions does it make you ask? 
c. Does the photograph allow you to make inferences, deductions, or generalizations about its 

content? 
 
5. Image Analysis 

a. Where was the photograph taken?  
b. What are the characteristics of the landscape – terrain, buildings, etc.?  
c. Who is in the photo?  
d. What are these people doing? 

 
6. Has the photograph been manipulated? 

a. Look for signs of manipulation – misplaced shadows, jagged edges, repetition. 
http://www.nationalgeographic.com/ngkids/0104/foolery/quiz1.html 
 

 
 
 

(Modified from an original web document by Dan McDowell - http://www.learnnc.org/articles/photo-process) 
  

 
 

Generating Ideas: Using Digital Images 
 

 

 
 

Integrated ICT  Grades 7-12  
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Developing and Organizing Ideas: Webbing and Mapping 
 

 

 
 

Integrated ICT  Grades 7-12  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Effective writers use different strategies to sort the ideas and information they have gathered in order to make 
connections, identify relationships, and determine possible directions and forms for their writing. Graphic 
organizer software such as SMART Ideas™ and Inspiration® can be used to group, regroup, sort, categorize, 
classify, and cluster notes and information. The webbing and mapping skills acquired through the use of this 
strategy can be integrated throughout the curriculum. 

Purpose 
• Identify relationships and make connections among ideas and information. 
• Select ideas and information for possible topics and subtopics. 
• Use graphic organizer software (e.g., SMART Ideas™, Inspiration®) to collect, organize and present 

information. 

Payoff 
Students will: 
• develop critical and creative thinking strategies; 
• learn how webbing and mapping strategies can be used throughout the writing process; and 
• use an electronic graphic organizer, organize ideas and information to focus the writing task. 

Tips and Resources 
• Strategies for webbing and mapping include: 

o Clustering – looking for similarities among ideas, information or things, and grouping them 
according to characteristics; 

o Comparing – identifying similarities among ideas, information, or things; 
o Contrasting – identifying differences among ideas, information, or things; 
o Generalizing – describing the overall picture based on the ideas and information presented; 
o Outlining – organizing main ideas, information, and supporting details based on their 

relationship to each other; 
o Relating – showing how events, situations, ideas and information are connected; 
o Sorting – arranging or separating into types, kinds, sizes, etc. and 
o Trend-spotting – identifying things that generally look or behave the same. 

• See Beyond Monet, chapter 10 pages 274-307. 
• See Student/Teacher Resource: Introduction to SMART Ideas™. 
• A SMART™ Board, Prometheus Board, or LCD projector would facilitate the teaching of this lesson.   

Further Support 
• Provide students with sample graphic organizers that guide them in sorting and organizing their 

information (e.g., from The Ontario Curriculum Unit Planner). 
• Have students create a variety of graphic organizers that they have successfully used for different writing 

tasks. Create a class collection for students to refer to and use.  
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Developing and Organizing Ideas: Webbing and Mapping 
 

 

 
 

Integrated ICT  Grades 7-12  
 

 
 

What teachers do What students do 
Before 
• Provide students with access to graphic 

organizer software (e.g., SMART™ Ideas, 
Inspiration®) to gather ideas and information. 

• Have students form discussion groups. Ask 
students to recall what they already know about 
the topic, and questions that they still have about 
the topic. Students record one idea or question 
on a computer using a SMART™ board or LCD 
projector. (See Student/Teacher Resource: 
Introduction to SMART Ideas™.) Encourage 
students to build on the ideas of others. After 
students have contributed everything they can 
recall about the topic, groups sort and organize 
their notes into meaningful clusters. Ask students 
to discuss connections and relationships, and 
identify possible category labels.  

• Prepare a web of possible ideas and information 
gathered on the topic.  

• Demonstrate how using a strategy such as 
webbing or mapping makes it easier to see 
connections and relationships and how writers 
often create a graphic organizer to manipulate 
and group their information into meaningful 
clusters. 

• Become familiar with mapping software 
such as SMART Ideas™ or Inspiration®. 

• Select a web template that best fits their 
thinking. 

• Recall what they already know about the 
topic and writing task. 

• Make connections to their own notes. 
• Note the links and connections that the 

teacher makes among ideas and 
information. Consider the similarities and 
differences of their own thinking. 

• Recall past use of a webbing strategy to 
record or organize thinking. 

 

During 
• Ask students to contribute to the web by 

identifying important ideas and key information 
and by suggesting how to place the points to 
create a web. 

• Ask students questions to clarify the decisions. 
For example: 

- Is this important? Why? 
- Is there another way to sort my notes? 

• Contribute to the discussion. 
• Note the similarities and differences in 

responses. 
• Place subtopics in appropriate branches 

of a main web structure. 
• Reorganize the web to fit with the main 

idea or argument. 

After 
• Have students refer to their notes for the writing 

task. 
• Ask students to create their own web, using the 

software, by sorting and organizing their ideas 
and information. 

• Ask students to export their webs to a word 
processor and use them to create an outline for 
writing. 

• Reread notes and identify important 
information and ideas. 

• Use the question prompts to re-phrase 
notes, identify key points, and group the 
ideas and information to create a web. 

• Share and compare webs. 
• Export information from the web to a 

word processor. 

 

Notes 
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The following examples are SMART Ideas™ templates 
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Developing and Organizing Ideas: Webbing and Mapping 

 
 

 

ICT  Grade 11  (Introduction to Information Studies) 
 

 
 

Resources for Webbing and Mapping  
 
Note:  These websites were active at the time of writing.   
If teachers are going to have students select readings, ensure that they are still active and appropriate before distributing. 

 
 

Books and Articles 
 

Beyond Monet: The Artful Science of 
Instructional Integration 

Barrie Bennett and Carol Rolheiser, 2001. Bookation Inc., Toronto. ISBN 
0-9695388-3-9 

Graphic Organizers as Writing Tools Brovero, Marian Duffy.  Book Links. May 2004: 45-46 
The Effect of Concept Mapping to 
Enhance Text Comprehension and 
Summarization. 

Chang, Kuo-En., Sung, Yao-Ting., Chen, Ine-Dai.  The Journal of 
Experimental Education. 2002:  5-23. 

Great Teaching with Graphic 
Organizers 

Drapeau, Patti.  USA: Scholastic, 1998. 

Reflections on Effective Use of 
Graphic Organizers. 

Egan, Margaret. Journal of Adolescent & Adult Literacy.  May 1999:  641-
645. 

Graphic Organizers and Activities 
for Differentiated Instruction in 
Reading.   

Witherell, Nancy L., and McMacklin. USA: Scholastic, 2002. 

 
Software 

 
SMART Ideas™ http://www2.smarttech.com/st/en-US/Products/SMART+Ideas/default.htm 
Inspiration® Software http://www.inspiration.com/productinfo/inspiration/index.cfm 
OSAPAC http://www.osapac.org/ 

 
Web Resources 

 
Education Place® http://www.eduplace.com/graphicorganizer/ 
Concept Map Theory http://cmap.coginst.uwf.edu/info/printer.html 
How -to Concept Map  http://www.coun.uvic.ca/learn/program/hndouts/map_ho.html 
The Graphic Organizer http://www.graphic.org 
Write Design On-Line http://www.writedesignonline.com/organizers/ 
Region 15 Graphic Organizers http://www.region15.org/curriculum/graphicorg.html 
Technology - The Web Portal for 
Educators 

http://www.teach-nology.com/worksheets/graphic/ 

SMART Ideas™ Home http://www.edcompass.smarttech.com/ec/en-US/ 
SMART Ideas Activities http://www.edcompass.smarttech.com/ec/en-

US/Learning+Resources/Lesson+Activities/Smart+Ideas+Activities/ 
 
 

Teacher Resource 


